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Intr tion

Note: Aspen is no longer supported for older versions of Windows. It will now only run on Windows XP
systems. Only versions prior to 2.6.0 can be used on non-XP systems.

Aspen is a suite of programs that are used to analyze radiosonde sounding data. Quality control (Q/C)
procedures will remove questionable data values, apply a limited set of correction algorithms, and apply a
user controlled amount of smoothing to the data series. The Aspen programs perform levels determination
and WMO message coding, as defined by the FMH-3 handbook amd WMO coding tables. Graphical
presentation tools provide for convenient browsing and comparison of soundings.

Three programs comprise the Aspen package:
*  Aspen — an interactive MS Windows based Q/C program, with extensive graphical displays.

*  BatchAspen — an interactive MS Windows based program used to apply the Aspen Q/C procedures
to multiple soundings in a single run.

*  AspenQC—a Windows or Linux command line program that can analyze a single sounding

The primary documentation is found in the Aspen User Manual, which is installed in the Docs subdirectory
of the Aspen installation directory (by default: c:\Program Files\NCAR\Aspen). Behind the scenes, Aspen
performs extensive data manipulations. Users should carefully read the user manual.

The bulk of this ReadMe document contains a sequential listing of modifications made to successive
versions of the Aspen software package. Significant changes in program functionality and usage are
described here. It is important to read the applicable section when installing a new version of Aspen.

Installation

Installation of Aspen is trivial. Simply run the self-installing msi file (or the .exe file for pre-V2.6.0
versions of Aspen). The Aspen files will be written to the default directory c:\Program Files\NCAR\Aspen\.
It is recommended to use the default installation location. Any user can install Aspen under Windows98
and Windows2000. For versions prior to V2.6.0, administrator privileges are required to install Aspen on
Windows XP.

Icons for Aspen and BatchAspen will be created on the desktop, and added to the Start menu.

Sample data files are located in the Sample Data subdirectory. Documentation will be found in the Docs
subdirectory.

The ASPENPROG environment variable will be set to point to the directory containing the Aspen
executable files. Aspen uses ASPENPROG to locate online documents and default configuration files.
ASPENPROG should not be altered.

The Help menu item in Aspen and BatchAspen allow the user to display this ReadMe document and the
Aspen User Manual. For this to work properly, the system must have the Adobe Acrobat Reader installed
and associated with .pdf files.
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nfiguration

Configuration is perhaps the trickiest aspect of using Aspen. The Aspen configuration scheme uses XML
files (aspen.xml and aspen.dtd) to maintain configuration information. These files are kept in different
directories, depending on the version of Windows that Aspen is installed on. In all cases, the
ASPENCONFIG environment variable can be set to specify a custom location where the files are located.
However, this variable is not used during the installation process; the user must set this variable and copy
the files into that directory if desired.

Configuration files under Windows 98

Versions of Aspen prior to V2.6.0 can be installed on Windows 98. The aspen.xml and aspen.dtd
configuration files are installed into the main Aspen program directory (typically c¢:/Program
Files/NCAR/Aspen). The environment variable ASPENCONFIG is set to this directory, and an entry is
placed in autoexec.bat to set ASPENCONFIG. This variable is also set in the environment section of the
Windows 98 registry. aspen.xml and aspen.dtd can be edited directly by the user.

Configuration files under Windows NT/2000/XP

Since there may be multiple users on an NT/2000/XP machine, there needs to be copies of the
configuration files for each user. The following scheme handles this situation.

When Aspen is started, it will check the following three locations, in this order, for existing aspen.xml and
aspen.dtd files:

¢ c:\Documents and Settings\<user>\Application Data\Aspen)\

*  The directory specified by the ASPENCONFIG environment variable.

*  The working directory that Aspen is being run from.
If aspen.xml and aspen.dtd cannot be located in any of these places, Aspen will offer to copy default
configuration files first to ASPENCONFIG directory (if ASPENCONFIG is defined), or to c:\Documents
and Settings\<user>\Application Data\Aspen\. The user can make copies of aspen.xm! and aspen.dtd if
they wish to backup their existing Aspen configuration.
The “advanced” button on the System menu of the Control panel is used to access the environment
variables under Windows NT/2000/XP. The ASPENCONFIG environment variable can be set here if the
default configuration directory choice is not suitable.
Note that the directory c.:\Documents and Settings\<user>\Application Data is configured, by default, as a
hidden directory under Windows. Set options under the Windows Explorer -> View menu to show the
directory.

rsion 2.7.4 tember 17, 2

Known Deficiencies in Version 2.7.4

Surface winds are not computed when “Surface Alt Unknown” is checked. This is due to the dependency of
the surface wind computation on known altitudes (i.e. 10 or 12 m above surface), and can be fixed.
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What’s New in Version 2.7.4

Bug Fixes

The detrending in the Buddy Check, introduced in V2.7.3, was not working. This has been corrected.
Q/C Diagnostics File

Text diagnostic output from the Q/C processing can now be saved to a file. Data points removed by each of
the Q/C algorithms are tabulated. The diagnostic output is enabled by a new configuration option on the
configuration “Other” tab. The output file is located in either the directory that Aspen is installed in, or the
directory of the first file processed by Aspen during that run. Be sure to disable the option when not needed
in order to avoid littering the system with diagnostic files.

rsion 2 tember 1, 2
Known Deficiencies in Version 2.7.3

Surface winds are not computed when “Surface Alt Unknown” is checked. This is due to the dependency of
the surface wind computation on known altitudes (i.e. 10 or 12 m above surface), and can be fixed.

What’s New in Version 2.7.3

0/C Summary

Added reporting of the number of data points rejected by each Q/C algorithm, for each of the sounding
parameters. The summary information on the Summary Tab can be saved to a text file.

Visual Studio Upgrade

The project was upgraded to build under Visual Studio 2005. The software is now built on an XP system
running under Parallels on a MacBook Pro. Visual Studio creates executables that are about twice as large
as the previous version, leading to a 6MB increase in the size of the MSI.

Minor Fixes

Missing GPS vertical velocity changed from 999.0 to 99.0 a couple of years ago, and was just detected.
Now either 999.0 or 99.0 result in missing GPS vertical velocity. A minor bug in string trimming routines
was fixed. Limit the AEV field to 5 characters, and fix so that it is created correctly (it was 00000 in
v2.7.2). Fixed a minor memory leak in the ExtendedStatic user interface class. Added error checking on the
timetag decoding in AvapsFileHeader, to catch some dormant errors in Avaps file coding.

rsion 2.7.2 (February 11, 2
Known Deficiencies in Version 2.7.2

Surface winds are not computed when “Surface Alt Unknown” is checked. This is due to the dependency of
the surface wind computation on known altitudes (i.e. 10 or 12 m above surface), and can be fixed.
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What’s New in Version 2.7.2

Final Smoothing

Setting the final smoothing wavelength to 0 can disable the final smoothing. This is useful if Q/C
procedures are to be applied without any smoothing of the final data.

Minor Fixes

Fixed bug in AVAPS file decoding relating to the launch altitude and gps measurement. Application
version number now reports 4 version digits.

rsion 2.7.1 tember 25 2
Known Deficiencies in Version 2.7.1

Surface winds are not computed when “Surface Alt Unknown” is checked. This is due to the dependency of
the surface wind computation on known altitudes (i.e. 10 or 12 m above surface), and can be fixed.

What’s New in Version 2.7.1

Levels Editing

On the Levels tab, individual fields within a given level may be selectively disabled by clicking on the
field. The whole level may also be disabled by clicking on the level name.

Levels Plot Trace

The “Levels” button on the XY graph now displays a trace of the levels, along with the levels hot spot
symbols. When the levels are edited on the Levels tab, the changes are reflected in the Levels plot on the
XY graph.

Fixed Launch Wind Speed and Launch Wind Direction Overrides

These were not working correctly in previous version. The U and V time series were not being updated
with user specified values if only one of wind speed or wind direction were specified.

Designated Data Source and Destination Directories

A fixed data source and destination directory can be specified, so that the file selector for opening files
always starts in a specified directory, and saved products are saved in the same fixed location. This is
enabled by setting the FixedSrcEnabled configuration option to true, and setting the FixedSrcDir option to
the desired directory. Both of these options can be set on the configuration “other options” dialog tab.

TEMP Message Emailing

The email address for TEMP messages was being forced to uppercase. It can now be entered in mixed case.

rsion 2 1 July 2
Known Deficiencies in Version 2.6.5

Surface winds are not computed when “Surface Alt Unknown” is checked. This is due to the dependency of
the surface wind computation on known altitudes (i.e. 10 or 12 m above surface), and can be fixed.
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What’s New in Version 2.6.5

Backed out recent changes to launch altitude for AVAPS and GAUS formats, so that launch altitude returns
to being taken from the reported geopotential altitude, rather than the reported GPS altitude.

Bug Fixes
The DiscardBadCRCData Q/C option was not being saved after being changed. This has been fixed.
For BatchAspen, any configuration option changes are saved immediately and used in the current run of

BatchAspen. In previous versions, BatchAspen had to be stopped and restarted for configuration changes to
take effect.

rsion 2.6.4 (1 ne 2
Known Deficiencies in Version 2.6.4

Surface winds are not computed when “Surface Alt Unknown” is checked. This is due to the dependency of
the surface wind computation on known altitudes (i.e. 10 or 12 m above surface), and can be fixed.

What’s New in Version 2.6.4

Configuration Directories

The desktop shortcuts had the wrong working directory, and exposed a bug in the way Aspen handled
configuration files if they were in the working directory.

rsion 2 1 ne2
Known Deficiencies in Version 2.6.3

Surface winds are not computed when “Surface Alt Unknown” is checked. This is due to the dependency of
the surface wind computation on known altitudes (i.e. 10 or 12 m above surface), and can be fixed.

What’s New in Version 2.6.3

Dropsonde Wind Equilibration

The user can now set a wind equilibration period for dropsonde winds. Winds within this time period, after
the launch, will be discarded. This arose because the 53" has started using a GPS re-radiation chamber
prior to the launch, and so the sondes are transmitting winds as soon as they are ejected from the aircraft.
The first winds are not usable, as they represent the deceleration of the sonde after launch.

rsion 2.6.2 (1 ne 2
Known Deficiencies in Version 2.6.2

Surface winds are not computed when “Surface Alt Unknown” is checked. This is due to the dependency of
the surface wind computation on known altitudes (i.e. 10 or 12 m above surface), and can be fixed.
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What’s New in Version 2.6.2

File Formats

Yet another version of the AVAPS file has appeared, and Aspen has been modified to decode it properly.
The ptu time offset and the AVAPS file format indicators were changed in that file.

The Aspen version number now appears in the post processing comments of the EOL output file format.

Version 2.6.1 (24 May 2006)

Known Deficiencies in Version 2.6.1

Surface winds are not computed when “Surface Alt Unknown” is checked. This is due to the dependency of
the surface wind computation on known altitudes (i.e. 10 or 12 m above surface), and can be fixed.

What’s New in Version 2.6.1

Observed positions

The sonde positions provided in the input file can be retained, in favor of the integrated winds position. A
new Boolean configuration parameter, ReportObservedPos, has been added to select this option. The
default value is false. When set true, the raw position information is passed to the QC data sets, rather than
the position as integrated from the winds. This is useful in cases where the user wishes to take advantage of
a GPS position measured directly by the sonde. This option can be set on the “Other Options” tab of the
configuration dialog.

GPS altitude added to output files

The raw (i.e. observed) GPS altitude was added to the CSV, EOL and netCDF outout file formats. QC files
in these formats will contain both an integrated altitude obtained from the hypsometric equation, and the
raw observed value (typically GPS). Raw files in these formats will only report the raw observed GPS
altitude. Note that currently the only input files that might provide GPS altitudes are CSV and GAUS.

Latitude and longitude choice

The user can elect to use either the originally observed sonde position (usually GPS), or the wind integrated
position, reported in the latitude and longitude fields of the QC output files.

WMO Message

Added the ATCEF field to the 62626 group of WMO section 10. If the Obs number on the Comms tab is
blank, then an Obs number of 99 will be assigned in the TEMP DROP 62626 group.

File Formats

Aspen can now read and write the recently specified EOL sounding file format. Support was added for the
AVAPS file format version 1.6.

AspenQC

AspenQC now has a command line switch for specifying the configuration set name to be used, so that the
aspen.xml file doesn’t need to be edited in order to switch configuration sets.
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Administrative

The Aspen source code and supporting files have been migrated from the NCAR/EOL CVS repository to
the Subversion repository. This allows for more flexible and comprehensive revision control. The current
source code revision number now appears in the Help->About menu item.

rsion 2 21 June 2
Known Deficiencies in Version 2.6.0

Surface winds are not computed when “Surface Alt Unknown” is checked. This is due to the dependency of
the surface wind computation on known altitudes (i.e. 10 or 12 m above surface), and can be fixed.

What’s New in Version 2.6.0

Configuration files

When new configuration parameters are added to later versions of Aspen, the program will automatically
add them to a user’s existing aspen.xml configuration file. Thus, new parameters can be added to Aspen
without requiring the existing configuration file to be discarded and replaced by a newer version.

Dynamic correction

The smoothing wavelength for dynamic corrections (for tdry and winds) are now user settable, instead of
using the final smoothing wavelength. This was in response to significant variance being added as a result
of the dynamic correction, when the final smoothing wavelength was small (typical).

CRC rejection

Dropsonde data frames, which have a CRC error noted in the status field, are now rejected by default. The
configuration parameter DiscardBadCrcData was added to the “Other Options”tab of the configuration
dialog.

Upgrade to Windows Visual Studio .NET 2003

The compiler technology was upgraded from Visual Studio 6 to Visual Studio .NET 2003. While this is
transparent to the user, this compiler is much more standards compliant. The compiled code should also run
faster.

Switch to MSI install system

Aspen is now distributed as a Microsoft System Installer (MSI) package. This allows the install process to
take advantage of the MSI install/uninstall/repair/deployment functionality.

All DLLs and supporting files are now placed in the Aspen install directory. Previously, some DLLs were
installed in Windows system directories, which could lead to clashes with existing system files.

Users can install Aspen without having Administrator privileges.

Support dropped for Windows 98

Starting with Aspen V2.6.0, Windows 98 is no longer supported.
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Graphics

The windows graphing component has been upgraded from version 4 to version 5 of the Gigasoft
ProEssentials component.

rsion 2 15 December 2004
Known Deficiencies in Version 2.5.6

Surface winds are not computed when “Surface Alt Unknown” is checked. This is due to the dependency of
the surface wind computation on known altitudes (i.e. 10 or 12 m above surface), and can be fixed.

What’s New in Version 2.5.6

GAUS file support added

Aspen can now read GAUS format files. The GAUS files are very similar to MCASS files.

Skew-t shared with other projects

The skew-t code and graphics adapter arrangement were modified to allow sharing with other projects, and
Proessentials PEGraph dependencies removed from the skew-t code.

Fixed bug in levels coding

For upsondes, if there is no wind data throughout flight, Aspen would crash when coding the levels. This
has been fixed.

rsion 2.5.4 (1 ly 2004
Known Deficiencies in Version 2.5.4

Surface winds are not computed when “Surface Alt Unknown” is checked. This is due to the dependency of
the surface wind computation on known altitudes (i.e. 10 or 12 m above surface), and can be fixed.

What’s New in Version 2.5.4

ARWO WMO message upload

The temporary directory used to hold the WMO message during upload to the ARWO on the WC130J

aircraft previously had been set to “C:\”. Under Windows XP, this directory is not writable by non-

administrative users. Aspen was modified to use a system provided temporary file directory path.
rsion 2 11 July 2004

Known Deficiencies in Version 2.5.3

Surface winds are not computed when “Surface Alt Unknown” is checked. This is due to the dependency of
the surface wind computation on known altitudes (i.e. 10 or 12 m above surface), and can be fixed.
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What’s New in Version 2.5.3

Coded Message
Added standard pressure level for 150 mb. All these years, no one has noticed this missing level. Also fixed
the coding of missing wind groups for 200mb and 100mb levels, if the levels below them have winds (See
WMO 306 code table 1734).

rsion 2.5.2 ly 2004

Known Deficiencies in Version 2.5.2

Surface winds are not computed when “Surface Alt Unknown” is checked. This is due to the dependency of
the surface wind computation on known altitudes (i.e. 10 or 12 m above surface), and can be fixed.

What’s New in Version 2.5.2

Coded Message

Fixed coding of standard pressures in Part C. These are coded as mb, rather than tens of mb as is done in
Part A.

rsion 2.5.1 Iy 2004
Known Deficiencies in Version 2.5.1

Surface winds are not computed when “Surface Alt Unknown” is checked. This is due to the dependency of
the surface wind computation on known altitudes (i.e. 10 or 12 m above surface), and can be fixed.

What’s New in Version 2.5.1

Coded Message
Pressure coding for parts C and D was fixed. The fine print in the WMO 306 (“see note for P,,P,,P,,”...)
specifies that the pressure in these parts is reported in tenths of a mb. Thanks to Paul Cieselski of CSU for
detecting this problem.

rsion 2 1 ne 2004

Known Deficiencies in Version 2.5.0

Surface winds are not computed when “Surface Alt Unknown” is checked. This is due to the dependency of
the surface wind computation on known altitudes (i.e. 10 or 12 m above surface), and can be fixed.

AspenQC does not link under Solaris. It will no longer be supported for Solaris.
What’s New in Version 2.5.0

Splash Time

The splash time for dropsondes has been added to the 62626 group of the TEMPDROP section 10.
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Ambient Equilibration

When dropsondes are released from an aircraft, they must respond to a sudden change in environment. The
temperature, pressure and RH data are discarded during this period of equilibration. The length of this
period is a multiple of the sensor time constant. Previous versions of Aspen used a fixed number time
constants. A new scheme has been introduced which dynamically calculates the number of time constants
required to reach a given accuracy. This will allow for significantly better data recovery at the top of low
level drop soundings. The number of time constants required is based upon the difference in temperature
between the outside of the aircraft and the temperature measured by the sonde prior to launch., and uses the
exponential response to a step function to determine the appropriate number of time constants.

Summary Tab

An additional tab has been added to the main display. This “Summary” tab displays information about the
processing.

Abreviated Headers for Upsondes

Upsondes now have abbreviated headers coded for them. Two new configuration parameters
(“UpsondeAbrHdr” and “UpsondelCAQO”) are used to specify the abbreviated header code and the ICAO
code for upsonde TEMP, TEMP SHIP and TEMP MOBIL messages.

Emailing WMO Messages

The capability to email the WMO message has been added. This may be useful for real-time data delivery
situations, such as submission to the GTS via the NWS email data ingest system. The recipient address is
provided by a new configuration option: “TempEmailAddress”. A button is located on the WMO tab which
is used to initiate the email.

When the button is pressed, an email window will popup with the TEMP message. The user can activate or
cancel the email send from here, and also edit the recipients and message if necessary.

The email capability uses the default mail client (e.g. Outlook or Outlook Express). It is recommended that
recipient address be an alias from the mail client address book. The mail client should also be configured to

send plain text messages, and automatic line wrapping should be set to the maximum value.

This feature has only been tested using Outlook Express as the mail client.

rsion 2.4.3 (12 January 2004

Note: the interface for configuration of QC parameters has changed significantly with this release. Be sure
to read the Configuration section of these release notes, and the Configuration section in the Aspen User
Manual.

Known Deficiencies in Version 2.4.3

Surface winds are not computed when “Surface Alt Unknown” is checked. This is due to the dependency of
the surface wind computation on known altitudes (i.e. 10 or 12 m above surface), and can be fixed.

AspenQC does not link under Solaris. Sorting out the library specifications might fix this.
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What’s New in Version 2.4.3

Levels Processing and Message Coding

The threshold limits for GDL calculations can now be specified in the configuration. This capability was
added at the request of the National Hurricane Center, but it should be used with caution, since changes
may violate the specifications of the FMH-3.

Levels can now be edited, where the user can mark levels that should not be coded. The WMO message
will be recoded without the designated levels.

Tropopause detection has been fixed for levels generation. Previous code was not iterating over the
complete tropopause candidate region.

A bug was fixed which sometimes caused the highest data point to be labeled as a tropopause.

User configuration of the levels departure limit for determining GDL levels has been added. The threshold
can be set for temperature, relative humidity, wind speed and wind direction. Note that improper use of this
can cause the levels determination to be out of specification with the FMH-3.

A separate smoothing step for temperature has been added, solely for the purpose of tropopause
determination. The final Q/C’d temperature data is now smoothed before the tropopause is calculated. If
this is not done, small features in the temperature trace would cause tropopauses to be identified when they
are not a gross feature of the sounding. A configuration item (tropopause smoothing wavelength) was
added to allow the user to control the amount of smoothing.

A rounding problem in latitude and longitude that caused Marsden square coding errors has been fixed.
The 21212 group is not coded when the only winds available are from the flight level observation.
The default file extension for saved TEMP message files is changed to .txt.

An option has been added to cause a NNNN message terminator to be added to the end of TEMP messages.
This is only done when saving the TEMP message to a file.

Configuration

The system for configuration of QC parameters has been completely reworked. Configuration parameters
are now managed in an XML file. A “configuration set” is a named collection of QC parameters. Multiple
sets can be created, and used for different processing scenarios (e.g. perhaps “tropical storm”, and “winter
storm”). A particular set is designated as the currently active set. Be sure to read the Configuration section
in the Aspen User Manual.

The interface for editing configuration parameters has been consolidated and improved.

An interface for managing the collection of configuration sets has been created. The user can create, delete
and modify the named configuration sets.

“Hit Surface”, “Surface Altitude Unknown” and “Ignore Heights” were added to the configuration
parameters.

The labels in the Dropsonde RH channel selection were changed to “AVAPS selected”, “1”, and “2”.

Graphics

The graphing component was upgraded to ProEssentials V. 4.0
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A save option was added for X-Y and Skew-T graphics. JPG and PNG files can be created and saved using
the save buttons or file menu commands.

A plot width options for graphic file output was added. Plot widths are specified in pixels.
Vertical scrolling on zoomed plots has been enabled.

Bug fixed: if levels computation was turned off and the sounding recomputed, the old (out of date) levels)
were being plotted. This no longer happens.

Initial XY plot display is now QC thermodynamic data, pressure axis, levels enabled, with the XY grid.

Miscellaneous

The source code was upgraded to properly use the standard C++ library with the correct namespace syntax.
The netCDF library was upgraded to version 3.5.1 of.

The Apache xerces-c XML library was upgraded to version 2.3.0 of.

Help topics can now display the Release Notes and the Aspen User Manual.

The units definitions in the NetCDF file output were made compatible with Unidata /dunits conventions.
Some memory reference problems detected by Insure++ were corrected.

Fixed bugs in some of the file decoders.

Corrected the logic relating to the Unix timestamp and launch times. The launch time is now treated as
being in GMT throughout the program.

Output data filenames get a file root name derived from the root name of the input file, with RAW or QC
appended.

The default location for directories when opening sounding files and saving data products was fixed. In
some versions of Windows (e.g. NT, 2000 and XP), the default directory for any file chooser dialog would
be the last directory accessed, regardless of the whether the previous operation was a file open or a data
product save. This is a documented bug (or feature) in the more recent Windows versions. Aspen now will
open the file chooser in the directory where the previous open took place, for each type of file access
activity.

Added a standalone AspenQC program, which can be run from the command line under Windows and
Linux. File input and output is via standard input, or from named files.

Added support for the “comma separated variable” (CSV) file format. This format allows direct import and
export between Aspen and MS Excel, as well as providing a reasonable generic format for arbitrary data
sets.

Modified the default file naming convention for output files to match the typical windows usage, where the
file name extension identifies the type of data in the file. NetCDF, Class, JPG and PNG files now get the

extensions .nc, .cls, .jpg and .png, respectively.

Made significant additions to the user manual, especially concerning the QC parameters and configuration
management.
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Set the “Most Recently Used” file number limit to 16, since windows didn’t seem able to handle more than
this.

Added launch time to the Main tab display.
PgUp and PgDn buttons will now cause the Raw and QC tabular displays to scroll up or down.

Scrollbars fixed so that views can be scrolled when sounding windows are made smaller than the main
frame.

BatchAspen

Added csv file output option.

Added a menu bar.

Added configuration set selection, editing and management.
Rearranged user interface layout.

Fixed directory name configuration so that it is saved between runs.
Added configuration items for output directory locations.

AspenQC

Added capability to read data from standard input.

YVersions 2.2.3 and 2.3.x
Internal releases, often changing. Not for public distribution. Various changes added incrementally, and
released to selected users.
rsion 2.2.2 (2 tober 2001
Known Deficiencies in Version 2.2.2

Surface winds are not computed when “Surface Alt Unknown” is checked. This is due to the dependency of
the surface wind computation on known altitudes (i.e. 10 or 12 m above surface), and can be fixed.

What’s New in Version 2.2.2

Extensive changes were made to the source code so that the core Q/C routines could be built without MFC
dependencies, so that the code could be used on Unix platforms.

Fixed missing value (bad value) indicators, and units definitions, in the netCDF files.

Fixed bug which caused a crash in the levels determination of surface winds for upsondes, when “make
altitudes missing” was selected.

Added units to labels on the main tab.

09/17/07 18 of 33



Expanded the limits of the RH trace on the XY graph, to —1% to 101%, so that it is easier to discern
between missing RH values and 100% or 0% RH values.

Added option for operator to choose between RH1, RH2 or RH3 as the RH raw data source, but only for
AVAPS and MCASS type soundings.

rsion 2.2.1 (1 Iy 2001
Known Deficiencies in Version 2.2.1

Surface winds are not computed when “Surface Alt Unknown” is checked. This is due to the dependency of
the surface wind computation on known altitudes (i.e. 10 or 12 m above surface), and can be fixed.

What’s New in Version 2.2.1

Added miscellaneous option, allowing the user to disable the generation of the abbreviated header for the
TEMPDROP message.

Added option for setting the time span for position interpolation from the winds. Previously this was fixed
at 60 seconds, and if a wind gap were greater than this, the position integration would stop. The user can
now change the maximum gap width setting in under the miscellaneous options.

rsion 2.2 2 May 2001
Known Deficiencies in Version 2.2.0

Surface winds are not computed when “Surface Alt Unknown” is checked. This is due to the dependency of
the surface wind computation on known altitudes (i.e. 10 or 12 m above surface), and can be fixed.

What’s New in Version 2.2.0

Temperature time constant and ambient equilibration

Replaced the temperature time constant empirical formulation with an explicit calculation. The previous
version used a time constant that a parameterized function of pressure. Two functions were provided, based
on nominal ascent rates of 5 and 15 m/s. The new time constant is a function of pressure, temperature and
sensor ventilation rate.

The previous version gave a time constant that was not correct for drops that were launched from high
altitudes. Because the ambient equilibration routine uses the temperature time constant to determine how
much temperature and pressure data to discard right after the drop begins, an incorrect determination of this
region was being made. The new time constant correctly determines the appropriate ambient equilibration
routine.

In general, the new time constant is slightly smaller than the previous formulation. This will have a slight
impact on the dynamic temperature adjustment.

Removed the “Nominal Ascent Rate” selection from the options tab, as it is no longer needed for the
temperature time constant.

The ambient equilibration interval was increased from 5.5 temperature time constants to 7 time constants,

for pressure and temperature. This is to accommodate the slightly smaller temperature time constant, and
maintain consistency with the HAPS processing.
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Added “Sonde Mass” and “Parachute Area” parameters to the options tab, for cases where a non-standard
parachute and dropsonde are used. These parameters are used to calculate a theoretical fall rate, which is
needed to calculate the temperature time constant immediately after launch from the aircraft.

WMO message coding

The “Max wind” level has been corrected to code a maximum wind only if the level codes to 61 knots or
greater. Previously, maximum winds would code for 60 knots or larger.

Added a “forced doubtful heights” switch on the Comm tab, for TEMPDROP messages. If the operator
checks this box, a 51515 section is forced (if it does not already exist), and a 10161 group is added to the
section. The pressure limits for the group span the sounding.

Added section 7 (31313) group to Part A of the message, to match coding standards in WMO 306
Supplement 2.

Changed the formatting of the 62626 line, when saved to a file or transmitted to the ARWO. Long 62626
comments must be broken across multiple lines. If the break occurs between words in the comments, a
leading blank is added to the beginning of the next line, so that automated decoders can easily detect the
word break.

Modified the computation of the altitude for the WL150 comment in the 62626 group. It now takes into
account the height differences between the ptu and wind measurements.

Moved the computation of the max wind level to occur after the standard levels are computed, so that the
standard levels can be considered for the max wind.

BatchAspen

Added the BatchAspen application. This separate program can apply the Aspen Q/C processing to a large
set of sounding files at one time. BatchAspen shares all of its Q/C algorithms with Aspen, to insure that the
processing is identical. BatchAspen is an optional component, selected during the installation.

Appendix A of the Aspen User’s Manual describes the operation of BatchAspen.

Miscellaneous

Disabled the toolbar docking. This feature was not being used, and could potentially confuse some users if
it was accidentally activated.

The resizing problem noted in Version 2.0.0 has been fixed. The application window for each file new file
being analyzed now opens at the correct size.

The limit on the number of files that can be open at the same time has been increased to 20.

Enabled temperature sensor dynamic correction for up soundings.

Reworked the input file format detection so that Aspen can also process CLASS format files produced by
Aspen. Doing this, however, is probably a bad idea. Aspen can write dropsonde data in the CLASS format.
But if the file is then read back into Aspen, it will assume that it is a CLASS sounding, and apply incorrect
processing steps.

The Q/C’d vertical velocity (“Dz/Dt”) has been added to the Q/C tabulated data display.

The vertical velocity is not computed for aircraft point in the sounding, since this was leading to bogus
values in a region where the quantity is not accurately measured.
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RH lower limiting is now performed after the final smoothing step, so that negative RH values created by
the smoothing are eliminated.

Added sample data files for different types of sounding systems. The files are found under Program Files ->
NCAR -> Aspen -> Sample Data. Installation of the sample data is now optionally selected during the
install process.
Changed from the InstallShield to the Wise installer. The user will see very little difference in the
installation procedure.

rsion 2.1.9 (17 A t2
Known Deficiencies in Version 2.1.9

The resizing problem noted in Version 2.0.0 has not been fixed.

Successively processing many files (~30) during one run of Avaps Editor can cause the graphics displays to
become illegible. Restarting the program fixes the problem.

Surface winds are not computed when “Surface Alt Unknown” is checked. This is due to the dependency of
the surface wind computation on known altitudes (i.e. 10 or 12 m above surface), and can be fixed.

What’s New in Version 2.1.9
Added capability to process MCASS data files. These are observations made by the specialized NCAR
sounding system, which uses a dropsonde lifted by a balloon. The data files are typically quite large, and
users will want to set the QC filtering and final smoothing wavelengths to much larger values (e.g. 60s)
than the typical default values. Be sure to set the nominal ascent rate to 5 m/s. Dynamic correction for
temperature and winds, levels calculation, and TEMP message encoding should usually be disabled as well
for MCASS observations.

rsion 2.1.8 2 ne 2
Known Deficiencies in Version 2.1.8

The resizing problem noted in Version 2.0.0 has not been fixed.

Successively processing many files (~30) during one run of Avaps Editor can cause the graphics displays to
become illegible. Restarting the program fixes the problem.

Surface winds are not computed when “Surface Alt Unknown” is checked. This is due to the dependency of
the surface wind computation on known altitudes (i.e. 10 or 12 m above surface), and can be fixed.

What’s New in Version 2.1.8

62626 comment for "LAST REPORT" changed to read "LAST REPORT FROM OB 01 THRU xx TO
icao", where xx is the current observation number and icao is the ICAO indicator.

Fixed a bug in the environment radix report. This field was not updating in the 62626 comment after the
user changed it on the COMMS tab.

Fix similar problem in correction number.
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rsion 2.1 ne 2
Known Deficiencies in Version 2.1.7
The resizing problem noted in Version 2.0.0 has not been fixed.

Successively processing many files (~30) during one run of Avaps Editor can cause the graphics displays to
become illegible. Restarting the program fixes the problem.

Surface winds are not computed when “Surface Alt Unknown” is checked. This is due to the dependency of
the surface wind computation on known altitudes (i.e. 10 or 12 m above surface), and can be fixed.

What’s New in Version 2.1.7

If no winds are reported, the wind speed units indicator specifies mps instead of knots.
62626 messages will line wrap when necessary.

DLM WIND string added to the 62626 section.

WL150 string added to the 62626 section.

Bug fixed in launch altitude override. Previously, setting this override did not affect the downward height
integration.

For a dropsonde: If a mandatory level is created within 2mb below the flight level, but winds are not coded
for the level, use the flight level winds in that mandatory level.

Version 2.1.6 (11 Feb 2000)

Known Deficiencies in Version 2.1.6
The resizing problem noted in Version 2.0.0 has not been fixed.
Long messages in the 62626 group do not line wrap.

Successively processing many files (~30) during one run of Avaps Editor can cause the graphics displays to
become illegible. Restarting the program fixes the problem.

Surface winds are not computed when “Surface Alt Unknown” is checked. This is due to the dependency of
the surface wind computation on known altitudes (i.e. 10 or 12 m above surface), and can be fixed.

What’s New in Version 2.1.6

Added TEMP messages: TEMP, TEMP SHIP and TEMP MOBILE.

Status bar is updated more frequently during processing, and displays more detail.
Added launch parameter overrides for wind speed and wind direction.

Bug fixed in surface altitude specification.

Bug fixed in Class file read.
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Increased limits for filter and smoothing wavelengths.

Changed program name to Aspen.

rsion 2.1 an 2
Known Deficiencies in Version 2.1.5
The resizing problem noted in Version 2.0.0 has not been fixed.
Long messages in the 62626 group do not line wrap.
Launch wind speed and direction are not available for editing on the main tab.

Successively processing many files (~30) during one run of Avaps Editor can cause the graphics displays to
become illegible. Restarting the program fixes the problem.

Surface winds are not computed when “Surface Alt Unknown” is checked. This is due to the dependency of
the surface wind computation on known altitudes (i.e. 10 or 12 m above surface), and can be fixed.

What’s New in Version 2.1.5

Fixed protocol specification of Zmodem TEMP message transfer to ARWO. This was tested January 7,
2000 on WC130J #5301.

Double clicking a code group on the WMO tab opens the modify dialog.

The original group count and the modified group count are printed on the first page of the printed WMO
pages.

Move the “AEV” string in the 62626 message, so that it appears before ‘REXMIT OF OB’, ‘CORRECTED
RPT’, and ‘LAST REPORT TO... . It will be placed after all of the other codes in the 62626 line.

Version 2.1.4 (5 Jan 2000)

Known Deficiencies in Version 2.1.4

The resizing problem noted in Version 2.0.0 has not been fixed.

Long messages in the 62626 group do not line wrap.

Launch wind speed and direction are not available for editing on the main tab.

Successively processing many files (~30) during one run of Avaps Editor can cause the graphics displays to
become illegible. Restarting the program fixes the problem.

Surface winds are not computed when “Surface Alt Unknown” is checked. This is due to the dependency of
the surface wind computation on known altitudes (i.e. 10 or 12 m above surface), and can be fixed.

What’s New in Version 2.1.4

The 1000mb height will be extrapolated if the surface pressure is greater than or equal to 949.5mb and less
than 1000 mb, as per instructions from Scott Persinger (the upper limit used to be 950.0 mb).
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Added Zmodem protocol for transfer of TEMP message to the ARWO, for WC1301J aircraft.
Enhanced the editing procedures on the WMO tab. The original count of code groups is displayed, along
with the number of modified groups. The number of modified groups is the sum of groups inserted, deleted
and modified. Groups that are inserted are highlighted in green. Groups that are modified are highlighted in
red. A “Restore” button can be pressed to restore a modified group to its original value.
Bug fixed, where surface wind altitudes of 12m were being coded into the 62626 group.
Bug fixed, where edits to the abbreviated header, 61616 and 62626 groups are preserved when switching
between the WMO and Comm tabs. If fields on the Comm tab that affect these groups are changed, the
edits are lost.
Fixed a bug where the surface altitude was being initialized from the registry, rather than the value
specified in the sounding file.

rsion 2.1.3 2 1
Known Deficiencies in Version 2.1.3
The resizing problem noted in Version 2.0.0 has not been fixed.
Long messages in the 62626 group do not line wrap.

Launch wind speed and direction are not available for editing on the main tab.

Successively processing many files (~30) during one run of Avaps Editor can cause the graphics displays to
become illegible. Restarting the program fixes the problem.

Surface winds are not computed when “Surface Alt Unknown” is checked. This is due to the dependency of
the surface wind computation on known altitudes (i.e. 10 or 12 m above surface), and can be fixed.

What’s New in Version 2.1.3
Fixed bug where the surface wind speed and direction were being reversed for GLASS soundings.
Fixed bug which caused program to crash in the vertical velocity check if there were no launch winds and
no sonde winds.
rsion 2.1.2 (2 tober 1
Known Deficiencies in Version 2.1.2
The resizing problem noted in Version 2.0.0 has not been fixed.
Long messages in the 62626 group do not line wrap.
Launch wind speed and direction are not available for editing on the main tab.

Successively processing many files (~30) during one run of Avaps Editor can cause the graphics displays to
become illegible. Restarting the program fixes the problem.
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Surface winds are not computed when “Surface Alt Unknown” is checked. This is due to the dependency of
the surface wind computation on known altitudes (i.e. 10 or 12 m above surface), and can be fixed.

What’s New in Version 2.1.2

Added buttons on the graphics displays which allow data point markers and grid displays to be toggled on
and off.

Fixed heights logic for “Surface Alt Unknown”. Downward and upward integrations were confused
because of this switch.

Added display of a data status column on the Raw tab. For dropsonde, this shows a 1 if the checksum is
non-zero.

The end of drop time override fixed to insure that data within the tenth of a second that was chosen is
included. Previously, if a user specified a time to a tenth, if the point had a time a few hundredths greater

would not be included.

Added an option to specify the nominal descent rate, at either S m/s or 15 m/s. This affects the ambient
temperature and pressure equilibration processing, and the temperature dynamic adjustment.

If the last wind altitude is greater than 999m, it is not coded. This is at the request of James Franklin.

Included the Q/C parameters in the global parameters for netCDF Q/C file saves, and a couple of other
parameters in the global attributes for both the Q/C and raw netCDF saves.

In consultation with the NHC, the editor version number is coded in the 62626 group of a TEMPDROP
message, with an identifier of AEV.
rsion 2.1.1 (2 tember 1
Known Deficiencies in Version 2.1.1
The resizing problem noted in Version 2.0.0 has not been fixed.
Long messages in the 62626 group do not line wrap.
Launch wind speed and direction are not available for editing on the main tab.

Successively processing many files (~30) during one run of Avaps Editor can cause the graphics displays to
become illegible. Restarting the program fixes the problem.

Surface winds are not computed when “Surface Alt Unknown” is checked. This is due to the dependency of
the surface wind computation on known altitudes (i.e. 10 or 12 m above surface), and can be fixed.

What’s New in Version 2.1.1
Fixed a bug in the coding of the check digit.
Fixed a bug in the coding of heights that round to 1000 m.

GG group now rounds up to the next hour if minutes are equal to 30.
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rsion 2.1.0 (1 tember 1
Known Deficiencies in Version 2.1.0
The resizing problem noted in Version 2.0.0 has not been fixed.
Long messages in the 62626 group do not line wrap.
Launch wind speed and direction are not available for editing on the main tab.
What’s New in Version 2.1.0

A check was added for failures of the filtering routine in the filter check and the final smoothing. If the
filtering algorithm fails, the data is not modified, and a warning message is given to the user.

Avaps Editor can now process upsonde data formatted in the NCAR GLASS "D" file format. The program
alters (slightly) some of the processing algorithms for upsonde data.

Added capability to process NCAR CLASS files.

The smoothing of the QC pressure field now occurs before the pressure monotonic check, placing it two
QC steps ahead of where it was performed in previous versions. This places it before the Tdry dynamic
adjustment and the RH lower limit step.

Fixed surface winds determination to take into account the altitude of the surface.

Fixed wind barbs on skew-t plot to report in knots rather than mps.

The observation number on the COMMS tab is initialized to blank. If the user does not enter an observation
number, it will be reported as 01.

MXWNDBND choice was added to the environment drop down list on the Comm tab.
If winds are only reported for the launch observation, they are not processed.
Fixed bug where duplicate levels were being coded in XXBB.
A checkbox was added to the Main tab to indicate that the surface altitude is not known. This should be
checked when a dropsonde is dropped over land. It prevents the upward height integration from being
performed, and causes the heights to be taken from the downward integration.
rsion 2 A t1
Known Deficiencies in Version 2.0.8
The resizing problem noted in Version 2.0.0 has not been fixed.
Long messages in the 62626 group do not line wrap.
Flight level wind speed and direction are not available for editing on the main tab.
What’s New in Version 2.0.8

The skewT graph was changed to plot data as a line rather than as points.
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The file chooser is opened immediately when Avaps Editor is started. This behavior is configurable via the
Tools->Other Options menu.

Missing surface pressure is now coded correctly in the thermodynamic significant levels.

A bug in the coding of dew point depressions has been fixed. Earlier versions had an error in the rounding
of dew point depressions greater than 5 °C, and in the coding of dew point depressions between 5 °C and 6
°C.

A terminating character (“=") has been added to each WMO part.

A custom WMO abbreviated header code can be specified on the Comm tab. It will remain as the default
value until cleared.

A custom ICAO identifier can be specified in the ICAO drop down list on the Comm tab. It will be saved
as a choice for future runs of the editor.

Fixed a bug where blank lines were being added to WMO message when it was saved to disk.

rsion 2 Iy 1
Known Deficiencies in Version 2.0.7
The resizing problem noted in Version 2.0.0 has not been fixed.
Long messages in the 62626 group do not line wrap.
Flight level wind speed and direction are not available for editing on the main tab.
What’s New in Version 2.0.7

Added additional wind QC step, where winds are discarded if the GPS reported vertical velocity is
significantly different than the hydrostatically computed vertical velocity.

Added option to save Raw and QC data in netCDF files.

Increased the number of segments in the skew-t adiabatic and pseudo-adiabatic curves, to give them a
smoother appearance.

Fixed problem in coding of nn group in the XXBB part of the TEMP message. nn now restarts at 11 rather
than 00, for the temperature and wind groups.

Fixed an error in the position calculation. Positions (i.e. latitude and longitude) calculated by earlier
versions of Avaps Editor are incorrect.

Fixed a bug where the flight level wind speed and direction could be slightly modified in the Q/C data set.

An extrapolated mandatory level was being created both in section 2 and in section 9 if the sonde was
launched within 25 mb below a mandatory level. The former has been removed.

If only flight level winds were available for the entire sounding, they were getting coded twice in the 21212
group. This has been fixed.

Changed some level type names in the levels display tab.
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Added adjustment for the time difference between the PTU and wind measurements. The time difference is
used, along with the fall velocity, to compute the true height of wind measurements having the same time
tag as a PTU measurement. This height correction is used only in determination of the surface wind
heights, and the reported height of the last measured wind (in the 62626 group). The difference will be at
most +/- a few meters.

Modified the surface wind determination to match Franklin’s procedure. Surface winds are taken between
10 and 12 meters. This height is selected after correction by the adjustment described in the previous
paragraph.

WMO coding fixed so that calm winds are reported as “00000”.

WMO coding fixed so that north winds have a direction reported as 360, rather than 0.

Transmit time in the abbreviated header has been changed from the sounding launch time to the time that
the data file is opened, plus 2 minutes.

Downward height integration corrected so that the same result is obtained whether or not the surface hit is
selected.
rsion 2 1 Iy 1
Known Deficiencies in Version 2.0.6
The resizing problem noted in Version 2.0.0 has not been fixed.
What’s New in Version 2.0.6

Bounds checking is fixed for the correction number, observation number, mission id, eyewall azimuth and
retransmission number on the COMMS tab.

Added the sonde serial number to the description text, which appears on all graphics and text products.
Added forced line breaks at WMO 21212, 31313 and 51515 code groups.

Added PRINT and SAVE buttons to the WMO tab.

rsion 2 21 June 1
Known Deficiencies in Version 2.0.5
The resizing problem noted in Version 2.0.0 has not been fixed.
What’s New in Version 2.0.5

WMO message is now formatted in 11 columns instead of 12. The ADDS system is not able to handle lines
wider than 11 columns.

The README is now also distributed in a .txt file that can be opened by Wordpad.

The blank line following each part of the WMO message has been removed.
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Changed mean boundary layer wind speed units (in 62626 group) to be reported in knots, as per the
instruction manual for HAPS Editsonde.

If there is no data for the 62626 group, it is not included in the message.

Version 2.0.4 (17 June 1999)

Known Deficiencies in Version 2.0.4
The resizing problem noted in Version 2.0.0 has not been fixed.
What’s New in Version 2.0.4
Additional levels are not generated for wind direction when the wind speed is less than 10 knots.
The GDL limit for wind speed, at levels below 850 mb, is reduced from 10 kts to 2.5 kts.
A Save entry was added to the File menu. It is enabled only for tabs that support save functions, thus
currently enabled only for the WMO tab.
rsion 2 1 ne 1
Known Deficiencies in Version 2.0.3
The resizing problem noted in Version 2.0.0 has not been fixed.
Additional levels are generated for wind direction when the wind speed is less than 10 kts.

The GDL limit for winds, at pressures greater than 850 mb, needs to be reduced from 10 kts to 2.5 kts. This
is to conform to a coding rule change requested NHC.

What’s New in Version 2.0.3

Aircraft ID is included in the drop description.

Bug fixed which caused a crash if there was no launch line in the D file.

Estimated surface pressure are now coded in sections 5 and 6 of Part B of TEMPDROP message.

The dynamic pressure adjustment is fixed so that files created under all versions of the AVAPS Drop
program are processed correctly. This is done by removing the dynamic pressure error correction that was
recorded in the “Sonde Dynamic Errors” field in the D file, and then applying the correct value of -0.4 mb.
Analysis of D files that have the incorrect —1.5 mb dynamic pressure error will not have a surface pressure

that is 1.1 mb lower than that reported in Avaps Editor Versions 2.0.2 and earlier.

The TEMPDROP message formatting has been changed in order to minimize the total number of lines used
by a message. Line breaks are no longer inserted between sections.

The enter key problem has been fixed. Hitting the enter key no longer causes the tabs to get scrambled.

The Mission Id field on the Comm tab has been fixed so that it is saved between runs. This matches the
behavior of the Mission storm field.
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Version 2.0.2 (26 May 1999)

Known Deficiencies in Version 2.0.2
The resizing problem noted in Version 2.0.0 has not been fixed.

The “Enter” key problem from Version 2.0.1 has not been fixed. It has been identified as a bug in the third-
party index tab control, and a bug report has been sent to the manufacturer.

What’s New in Version 2.0.2
Overriding the launch pressure was causing the levels to get mixed up. This has been fixed.

The “ShowFocusRect” property of the tab control has been set to false. This removes the (unnecessary)
dashed rectangle that appeared around the text of the selected tab.

The “Lowest Winds” level was being incorrectly labeled in the Levels tab as “Highest Winds”. The label
has been corrected.

Level detection algorithm for the maximum winds, which is coded in the 77 group, was changed to match
the WMO 306 specifications. Previously, the QC data set was used to determine this level. Now it is chosen
from among the existing significant levels.

Enlarged the Levels “hotspot” displays on the XY graph to eliminate text clipping.

If the sonde position can not be integrated all of the way to the surface, the last calculated position is used
for the splash location, if it is below 850 mb.

Fixed minor bug in position algorithm that occasionally caused the splash position to not be calculated.

Version 2.0.1 (21 May 1999)

Known Deficiencies in Version 2.0.1
The resizing problem noted in Version 2.0.0 has not been fixed.

A serious problem exists, where if the user hits the “Enter” key, while either on the Main tab or the Comms
tab, the tabs become scrambled. The user can close the sounding and reopen it to repeat the QC processing.

What’s New in Version 2.0.1

The QC tab now removes the old data values before displaying the new results from a recompute operation.
A bug in standard levels, which caused an exception when the QC data is very sparse, was fixed.

QC parameters can be reset to default values from the main file menu, without opening a sounding file.
The number of files open at the same time is limited to 6, to avoid using up Windows resources.

The equipment type code group a4 changed to 8 for satellite navigation.

Missing surface pressure is now reported as three solidii instead of five solidii.

The Tab dialogs were expanded to make full use of the tab areas.
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A sounding description box was added to the Comm tab.

Implemented the 62626 group in WMO message, and added controls for its configuration on the Comm
tab.

Fixed field width formatting was applied to 61616 group coding.

Version 2.0.0 (17 May 1999)

Known Deficiencies in Version 2.0.0

The resizing capabilities within the Multiple Document Interface have not been enabled. When a user
resizes one of the windows containing a particular sounding, the contents of the window will be clipped.
Occasionally, when the window is maximized again, it will not fill the entire area correctly. If the user
simply iconifies that window and maximizes it again, it should return properly to full size. This problem
appears to occur sometimes after print previewing as well.

The cause of the resizing problem stems from a defective third party control that provides window-resizing
capabilities for Visual C++ applications. We are working with the manufacturer to resolve the issue.

The recently introduced specification for the 62626 code group in the WMO TEMPDROP section 10 has
not yet been implemented. Development of this capability is currently in progress.

What’s New in Version 2.0.0

This is the first release of Avaps Editor Version 2. This version contains many changes and enhancements
over Avaps Editor Version 1. The major changes are summarized below.

Performance

The processing speed is roughly 5 to 10 times faster than version 1. This is due mainly to the use of
optimized C++ source code, and design modifications to the processing algorithms.

User Interface

The user interface is based on the standard Microsoft Multiple Document Interface (MDI). This interface
allows multiple soundings to be opened and processed concurrently within the editor. This makes it very
convenient to compare multiple drops. The MDI will be familiar to users of common Windows based
software; for instance it is the interface found in applications such as Microsoft Word and Excel.

QC Algorithms

The quality control algorithms are based on a different strategy. In version 1, the raw sounding data was
structured into an array of time slices, with missing data indicators entered for parameters if they were
missing at a given time step. This array was then analyzed, with data quality metrics assigned to each data
point. In some cases, parameters are interpolated across missing data gaps. This scheme could allow the
user to manually manipulate the quality metrics, and thus subjectively influence the inclusion of any data
parameter at any time. Note however, that this subjective editing capability was not made available to the
user in version 1.

In version 2, the approach is to start with the time series of each raw data parameter. A battery of quality
control tests is applied to the time series, and data points that fail to pass are simply removed from the time
series. The final smoothing step will replace the acceptable raw data points with their smoothed values.
Thus, at the end of the quality control processing, data values only exist at points where an original
observation was found in the raw data set.
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The estimation of the surface pressure has been improved. Version 1 assumed that the last pressure reading
of the sounding was the surface pressure. James Franklin’s analysis of the sonde telemetry has been utilized
to estimate a more accurate surface pressure, which will provide improved surface pressure and height
reports. Note that this can cause discrepancies on the order of 10m between the heights for a sounding
analyzed by both versions 1 and 2.

Algorithms to perform dynamic corrections for temperature and wind speed have been added.

QC Configuration and Control

User specification of the quality control parameters has been implemented. A set of property pages allows
the user to change the limits that are enforced by the various quality control algorithms.

The Ooyama filtering and interpolation scheme was studied and implemented as a stand alone class library.
It is used extensively throughout Avaps Editor Version 2.

Several important user controls have been provided in Version 2:
*  The observed aircraft flight level data can be overridden as necessary.
*  The end of the drop time can be specified by the user.
* The user can designate whether or not the sounding reached the surface.
¢ The user can elect to not make use of the calculated altitudes.

After the processing parameters are changed, the user presses a “RECOMPUTE” button to reprocess the
sounding using the new parameters.

Printing

The standard Windows printing and print preview interface has been implemented for all text based data
presentations. This provides the standard preview capability which allows the user to select particular pages
to be printed. The standard Windows printer configuration scheme will be familiar to Windows users.

Levels Coding

The levels coding algorithms have been modularized and separated from the WMO coding sections of
Avaps Editor. This will make the software more adaptable to changes and easier to maintain.

A “Levels” tab has been added to the main display. This provides a listing of the analyzed levels, with their
relevant data parameters. Standard levels are highlighted, and the list can be sorted by any parameter, such

as level type, time or pressure. This display will be very useful in examining the source level that led to the
creation of a particular WMO code group.

WMO Message

WMO message coding is, as a result of its definition, very hierarchical in nature. Thus the message coding
software was reformulated as a class library with a structure that mirrors the rules defined in the WMO
coding manuals.

Deficiencies in the WMO message editing have been addressed. The user may now edit the 61616 group

parameters without causing other edits to the message from being lost. Code groups are edited individually
so that inadvertent changes to adjacent groups are minimized.
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Graphics

Significant improvements have been made to the two graphical displays.

Skew-T

This product has been rewritten so that when the display limits of the skew-t graph are changed, the
reference lines (e.g. adiatbats and isotherms) are redrawn and relabeled. In version 1, when the user
zoomed the area within the skew-t, the reference line labeling was lost.

The zoom area is selected with the mouse pointer.

XY-Graph

The most significant change to the XY-graph is the ability to now overlay the analyzed levels on the graph.
“Hot-spot” capability causes the level type name and pressure to pop up on the display when the user
positions the mouse pointer over a level symbol on the graph.

A graph of the pressure fall velocity versus the GPS measured fall velocity has been added.

Software Technology

Version 1 of Avaps Editor was built on a combination of Fortran, Visual Basic and Visual C++. This
conglomeration of technologies led to a software package which had become increasingly difficult to
maintain, and which had performance penalties due to the Fortran and Basic code. Version 2 is based
completely on Visual C++, building upon the Microsoft Foundation Class application framework. This
approach has allowed for a completely object oriented software design, which is more resilient to
requirements changes and easier to maintain. Use of Visual C++ has led to a significant improvement in
processing performance, and the presentation of an industry standard user interface.
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